Syllabus

**Course Information:**
- **Course Title:** Introduction to Online Learning
- **CRN:** 12345
- **Credits:** 3
- **Term:** Winter 2014

**Instructor Information:**
Hello! My name is John Doe, and I'll be your instructor for this course. I've taught this course online for the past two years. Each time I teach it, I learn something new.

**Assignments/Assessments:**

**Grading Scale**

<table>
<thead>
<tr>
<th>Grade</th>
<th>Grading Scale by Points</th>
<th>Grading Scale by Percentages</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>202 - 225 +</td>
<td>90 - 100%</td>
</tr>
<tr>
<td>B</td>
<td>180 - 201</td>
<td>80 - 89%</td>
</tr>
<tr>
<td>C (or P)</td>
<td>157 - 179</td>
<td>70 - 79%</td>
</tr>
<tr>
<td>D</td>
<td>135 - 156</td>
<td>60 - 69%</td>
</tr>
<tr>
<td>F (or NP)</td>
<td>&lt; 134</td>
<td>&lt; 59%</td>
</tr>
</tbody>
</table>

**Late Work & Make-up Policy**
Assignments must be completed on time in order to earn full credit. 
(Late assignments will earn 50% credit.)

**Special Accommodations:**
Students who experience disability-related barriers should contact Disability Services (www.uwf.edu/sdrc). If students elect to use approved academic adjustments, they must provide in advance formal notification from Disability Services to the instructor.

**DL 101 - Online Learning Best Practices**

**Best Practices when using complex graphics:**
When using complex images, include Alt text as you would for any other image but also include additional description as a caption. If more description is needed, include it in the content of the page.

This graph summarizes the growth of students using home broadband the period from January 2004 to 2008. The percentage increased from 22% in 2004 to 48% in 2008.
Web Accessibility

Adhering to web accessibility guidelines while developing your online course will benefit all students including those with visual, hearing, mobility and learning disabilities.

UWF Web Accessibility Guidelines

Accessibility Guidelines for Online Course Content are based on the internationally accepted Web Content Accessibility Guidelines AA standards (WCAG 2.0).*

This handbook is a reference guide.

* Web Content Accessibility Guidelines 2.0, W3C World Wide Web Consortium Recommendation 12 Month Year (http://www.w3.org/TR/2008/REC-WCAG20-20081211/, Latest version at http://www.w3.org/TR/WCAG20/)

Required by Federal Law

"Requiring use of an emerging technology in a classroom environment when the technology is inaccessible to an entire population of individuals with disabilities... is discrimination prohibited by the Americans with Disabilities Act of 1990 (ADA) and Section 504 of the Rehabilitation Act of 1973 (Section 504) unless those individuals are provided accommodations or modifications that permit them to receive all the educational benefits provided by the technology in an equally effective and equally integrated manner."

Source: 6/29/2010
Dear Colleague letter sent to every college and university president
http://www2.ed.gov/about/offices/list/ocr/letters/colleague-20100629.html
# WEB Accessibility Guidelines

<table>
<thead>
<tr>
<th>Component</th>
<th>Guideline</th>
<th>Why Is This Important?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Headings</strong></td>
<td>Use properly formatted headings to structure a page.</td>
<td>Headings help organize your content, making it easier for everyone to read. Headings are a primary way to navigate pages using screen reading software.</td>
</tr>
<tr>
<td><strong>Lists</strong></td>
<td>Format lists as proper lists.</td>
<td>When typing a list, use the proper tools to make a list. Properly formatted numbered lists and bulleted lists are accessible.</td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td>Write meaningful link text.</td>
<td>Links embedded in text should describe the link’s destination. It helps users navigate the page more quickly.</td>
</tr>
</tbody>
</table>
| **Tables**     | Create tables with column and/or row headers, and ensure a proper reading order. | - **Why Column Headers in a Data Table are Important**  
                  Table headers are essential to understanding how the information is organized.  

- **Why the Reading Order in a Table is Important**  
                  Screen readers read tables from left to right, top to bottom, one cell at a time (& only once). If cells are split or merged, check the reading order. |
| **Color**      | - Use sufficient color contrast.  
                  - Don’t use color alone to convey meaning. | Without sufficient color contrast between font and background, people who are color blind and low vision will not benefit from the information. And using color alone to convey meaning will leave those who are color blind or blind unable to interpret the meaning. |
| **Keyboard Accessibility** | Ensure that any action that uses a mouse, can also be completed using only the keyboard. | Mobility and visual disabilities often prevent people from using a mouse. If content is not keyboard accessible, it will limit many people’s opportunities to learn from the content. |
| **Image ALT text** | Provide alternative (Alt) text descriptions for images. | Alt text is read by a screen reader. It should adequately describe what is being displayed and why it’s important. This allows screen reader users to benefit from the information being conveyed by the image, even if they cannot see it. |
# WEB Accessibility Guidelines

<table>
<thead>
<tr>
<th>Component</th>
<th>Guideline</th>
<th>Why Is This Important?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation</td>
<td>Design clear and consistent navigation.</td>
<td>Clear and consistent navigation in your course will allow students to focus on your content rather than on how to find it.</td>
</tr>
<tr>
<td>Blinking Limit</td>
<td>Eliminate or limit blinking / flashing content to 3 seconds.</td>
<td>Blinking content is not only distracting it can cause seizures in persons with a photosensitive disorder.</td>
</tr>
</tbody>
</table>
| Forms           | Label form fields and buttons clearly, and ensure a proper reading order in a form. | ■ Why the reading order of a form is important  
Using the tab key, your cursor should follow through the form in the same order it is intended to be completed.  
■ Why labeling buttons and form fields is important  
A screen reader will identify the field by reading the label. It should adequately describe what should be filled in. |
| Caption Video   | Provide captions or transcripts for video produced, if it will be used for more than one term. | Video captions benefit everyone. Captions are essential for deaf and hard of hearing viewers. They also assist non-native English speakers who can read along while listening. (Note: Videos should have a keyboard accessible player.) |
| Transcribe Audio| Provide a transcript for audio you produce, if it will be used for more than one term. | Audio transcripts benefit everyone. They are essential for the deaf and hard of hearing and they assist non-native English speakers who can read along while listening. |
| Required Software| Require only accessible software & applications.                          | Inaccessible software and applications will shut students with disabilities out. Ask the software developer for a VPAT (Voluntary Product Accessibility Template) to help determine the product’s accessibility. |
| Math & Science  | Write math and science equations accessibly.                              | Use an accessible equation editor to write scientific notations, equations and formulas. This will allow screen readers to read equations properly. |
# How to Make Accessible PowerPoints

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
</table>
| **Outline View**         | ▪ Check the outline view.  
▪ Compose your outline in the outline view, and then move to the slide view to add images and design. | 1. Click on View tab in the Presentation Views group (Mac: View menu.)  
2. Choose Normal (PowerPoint 2013: click on Outline View instead of Normal button.)  
3. In the Outline panel, make sure all text from the slides appears in the Outline View. |
| **Slide Layout**         | ▪ Use the PowerPoint provided slide layouts when building slides.               | From Home tab, choose the New Slide drop down menu and select a slide template.                                                                            |
| **Reading Order**        | ▪ Check the slide’s reading order.                                             | 1. Click on the slide without selecting any of the content placeholders.  
2. Using the keyboard, tab through the slide. This is the reading order of the slide (meaning that is the order a screen reader will read the content.) |
|                          | ▪ Change the reading order.                                                   | 1. On the Home tab, click on Arrange and choose Selection Pane  
(Reorder Objects for Mac - MS PowerPoint 2011.)  
2. Tab through the slide and the corresponding element will highlight.  
3. On the Selection Pane, click arrow up and down icon (On Mac, drag layers) to re-arrange the reading order, reading order begins at the bottom and moves to the top (On Mac, highest number is read first.) |
| **Images, Clipart, Shapes** | ▪ Add alternative (Alt) text to images and shapes.                               | 1. Right click on the image and select Format Picture.  
2. Select Alt Text on the sidebar (PowerPoint 2013: click the icon to open Alt text field.)  
3. Enter appropriate alt text in the Description field (not the Title field.) |
| **Lists**                | ▪ Format a list as a list using Numbering or Bullets lists.                     | Click on the Home tab. In the Paragraph group, select the Numbering or Bullets icon.  
▪ Use Numbering lists if a sequential order is important to the list.  
▪ Use Bullets lists if all items are of equal value. |
## How to Make Accessible PowerPoints

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
</table>
| Links           | ■ Create a meaningful link that describes its destination.                      | 1. Type out text that describes the destination of the link. For example: UWF Homepage.  
2. Select the text, right click and choose **Hyperlink...** from the menu.  
3. The **Insert Hyperlink** window will open. Enter a complete URL address in the **Address** field.  
(Mac - PowerPoint 2011: **Link to** field.) For example: http://www.XZI.edu.  
4. Click the **OK** button to save the link.                                                                                                                                 |
| Tables          | ■ Indicate column headers for data tables.                                      | 1. Place the cursor in the top row of your data table.  
2. Click on the **Design** tab under **Table Tools** (Mac - PowerPoint 2011: **Table** tab.)  
3. In the **Table Style Options** group, select the **Header Row** check box.  
4. Now the cells in the top row of your table make up the headers for the columns.                                                                                                                                 |
|                 | ■ Check the reading order.                                                      | ■ The screen reader reads a table from left to right, and top to bottom (never repeating a cell.)  
■ Merged, nested, and split cells may change the reading order of a table.  
■ Make sure you construct your table in a way that accommodates a good reading order.                                                                                                                                 |
| Color           | ■ Use sufficient color contrast.                                                 | ■ Make sure there is enough color contrast between the text and background colors.  
■ Without sufficient color contrast, people who are low-vision and color blind will not benefit from the information.                                                                                                                                 |
|                 | ■ Don't use color alone to convey meaning.                                     | Don't use color alone to make a distinction, a comparison or to set something off or apart from the rest of the document. If you categorize something by color alone, those who are color blind or blind will not be able to benefit from the information. |
| Math & Science  | ■ Math cannot be written accessibly in PowerPoint.                              |                                                                                                                                                           |
| Video & Audio   | ■ Link out to media.                                                            | Provide captions or a transcript for video that you produce, if it will be used for more than one term. Make sure the video player is keyboard accessible. |
# How to Make Accessible Desire2Learn Web Pages

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Template</strong></td>
<td>- Use the most current Desire2Learn template.</td>
<td>- If you don't have the most current template, contact the Faculty Help Desk or your campus Instructional Technology Specialist.</td>
</tr>
<tr>
<td><strong>Headings</strong></td>
<td>- Properly format headings.</td>
<td>- Highlight the text and select the Heading # from the drop-down Format menu on the tool bar.</td>
</tr>
<tr>
<td></td>
<td>- Use headings in the correct order.</td>
<td>- There can be only one Heading 1 (h1) per page. But there can be multiple h2, h3, h4, h5, h6. <strong>DO NOT</strong> skip heading levels.</td>
</tr>
</tbody>
</table>
| **Images** | - Add alternative (Alt) text to images. | 1. Place the cursor where you want to insert an image, and click the **Insert image** icon from the toolbar. The **Add a File** window will open.  
2. Browse to the image location and select the image file. Click **Done** button (**Add** button in D2L 10.3).  
3. The **Provide Alternative Text** window will open. Describe the purpose of the image in the **Alternative Text** field or check the box if the image is just decorative.  
4. Click **OK**. |
| **Lists** | - Format a list as a list using Ordered or Unordered lists. | 1. Select the content you want to make into a list.  
2. From the toolbar, click the **Unordered List** icon if the order doesn't matter or select **Ordered List** from the drop-down menu if the order does matter. |
| **Links** | - Write meaningful link text that indicates the link’s destination. | 1. From the toolbar, click on the **Insert Quicklink** icon .  
2. Select **URL** in the **Insert Quicklink** window  
   - Type in the URL (web address).  
   - Enter text that describes the link’s destination in the **Link Caption** field (in the **Title** field in D2L 10.3)  
   - Select **Whole Window** in the **Open In** section (**Target** section in D2L 10.3).  
3. Click the **Insert** button.  
4. Click the **Update** button to save your changes. |
## How to Make Accessible Desire2Learn Web Pages

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
</table>
| **Tables**  | - Identify column or row headers for data tables.                               | 1. Place the cursor in one of the cells to be marked up as a column header.  
2. Click on the drop-down menu next to the Table icon in the toolbar.  
3. Choose **Table Cell Properties**. The Table cell properties window will open.  
4. In the **Cell type** field, click on the drop-down list and select **Header**.  
5. In the **Scope** field, click on the drop-down list and select **Col**.  
6. To make all of the cells in this row into headers, choose **Update all Cells in the Row**.  
7. Click **Update** to save. |
|             | - Check the reading order.                                                        | **A screen reader reads tables from left to right, and top to bottom, never repeating a cell.**  
**Merged, nested, and split cells may alter the reading order of a table.**  
**Make sure you construct your tables in a way that accommodates a good reading order.** |
| **Color**   | - Use sufficient color contrast.                                                   | 1. Select the text that you want to change to another color and click drop-down menu next to the **Color** icon in the toolbar.  
2. Select the color and click **Save**.  
**Note:** When picking a color for your text in Desire2Learn, make sure you choose a color that registers with a green checkmark for WCAG AA in the **Select a Color** palette ✅ **WCAG AA**.  
- Don't use color alone to convey meaning.  
**Don't use color alone to make a distinction, a comparison or to set something apart from the rest of the web page. If you categorize something by color alone, those who are color blind or blind will not benefit from the color distinction.** |
| **Math & Science** | - Write math and science equations using MathML.                               | Use the D2L equation editor.  
For more information, go to the Math & Science page in this handbook. |
| **Multimedia** | - Eliminate or limit blinking/flashing content to 3 seconds.                    | **Animation**  
- **Interactive graphics**  
- **Video & Audio**  
**Make sure all mouse actions can be completed with a keyboard alone (without a mouse.)**  
**If you create video, it must be captioned. If you create audio file, it must be transcribed. For more information, go to the Video & Audio page in this handbook.** |
# How to Make Accessible Word Documents

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
</table>
| Headings      | - Properly format headings.                                                       | 1. Select the text that you want to make into a heading.  
2. Go to the **Home** tab.  
3. Choose the appropriate heading level from the **Styles** group. |
|               | - Use headings in the correct order.                                             | - The Heading 1 should only be used **ONCE** per page. Heading 2, 3, etc. can be used multiple times.  
- **DO NOT** skip heading levels.                                      |
| Images        | - Add alternative (Alt) text to images.                                          | 1. Right click on the image, and select **Format Picture....**  
2. The **Format Picture** window will open.  
3. Select **Alt text** (Word 2013: select the icon. Then click on to expand Alt text.)  
4. Enter your image description in the **Description** field (Not in the **Title** field.) |
| Lists         | - Format a list as a list using Numbering or Bullets lists.                     | 1. Select the text that you want to make into a list.  
2. On the **Home** tab, in the **Paragraph** group, select the **Bullets** or **Numbering** icon.  |
| Links         | - Create a meaningful link that describes its destination.                      | 1. Type out text that describes the destination of the link. For example: UWF Homepage.  
2. Select the text, right click and choose **Hyperlink...** from the menu.  
3. The **Insert Hyperlink** window will open. Enter a complete URL address in the **Address** field  
   (Mac - Word 2011: **Link to** field.) For example: http://www.uwf.edu.  
4. Click the **OK** button to save the link.                                      |
- For LibreOffice, just use the native equation editor which easily converts to an accessible format. |
# How to Make Accessible Word Documents

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
</table>
| **Tables** | ★ Indicate column headers for data tables. | 1. Place the cursor in the top row of your data table.  
2. Click on the Design tab under Table Tools (Table tab on Mac - Word 2011.)  
3. In the Table Style Options group, select the Header Row check box.  
4. Click on the Layout tab under Table Tools (Table Layout tab on Mac - Word 2011.)  
5. Click the Repeat Header Row button. This will indicate the top row as the table's header. |  
| | ★ Check the reading order. | - The screen reader reads a table from left to right, and top to bottom (never repeating a cell.)  
- Merged, nested, and split cells may change the reading order of a table.  
- Make sure you construct your table in a way that accommodates a good reading order. |  
| **Color** | ★ Use sufficient color contrast. | - Make sure there is enough color contrast between the font and its background colors.  
- Without sufficient color contrast, people who are low-vision and color blind will not benefit from the information. |  
| | ★ Don't use color alone to convey meaning. | - Don't use color alone to make a distinction, a comparison or to set something off or apart from the rest of the document. If you categorize something by color alone, those who are color blind or blind will not be able to benefit from the information. |  
| **Forms** | ★ Label form fields and buttons. | - Use real text labels or alternative text when creating buttons and form fields.  
- Use a form template to create a form. |  
| | ★ Check the reading order of forms. | - To check, press the tab key repeatedly to replicate the order a screen reader would navigate through the form. If it doesn’t land on the form fields in the correct order, you will need to edit the form.  
- The tab order (or reading order) is important to those who are blind or physically disabled. |
# How to Make Accessible PDFs

## 2 Ways to create a PDF

<table>
<thead>
<tr>
<th>Convert MS Office to an Accessible PDF document</th>
<th>Software / Hardware</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Microsoft Office 2010</td>
<td></td>
<td>1. Start with a well-structured word document or presentation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Click the <strong>File</strong> tab and select <strong>Save as</strong>. In the <strong>Save as type</strong> field, select <strong>PDF (<em>.pdf.</em>)</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Enter a file name in the <strong>File name</strong> field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click on the <strong>Options</strong> button and make sure the Document structure tags for accessibility and Create bookmarks using Headings checkboxes are checked.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Click <strong>OK</strong> and <strong>Save</strong>. This will tag all of the text formatting so page headings and lists are correctly interpreted by a screen reader.</td>
</tr>
<tr>
<td>MS Office 2011 (for Mac)</td>
<td>- Microsoft Word &amp; PowerPoint 2011 for the Mac cannot produce a fully accessible PDF.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Go to <a href="http://www.pcc.edu/resources/instructional-support/access/pdfs-from-mac.html">http://www.pcc.edu/resources/instructional-support/access/pdfs-from-mac.html</a> for options on how to create an accessible PDF.</td>
<td></td>
</tr>
</tbody>
</table>

## When needed: Run Optical Character Recognition (OCR)

<table>
<thead>
<tr>
<th>Adobe Acrobat Pro</th>
<th>1. Open your PDF file.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Open the <strong>Tools</strong> panel (click <strong>Tools</strong> in top right) and click <strong>Recognize Text</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>In This File</strong> and the <strong>Edit</strong> button to adjust your OCR settings. Select the language of the text and choose <strong>Searchable Image</strong> for PDF Output Style and Downsampling to <strong>600 dpi</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>OK</strong> when done.</td>
</tr>
</tbody>
</table>
# How to Make Accessible Video & Audio

<table>
<thead>
<tr>
<th>Component</th>
<th>Best Practices</th>
<th>How to Make it Accessible</th>
</tr>
</thead>
</table>
| **Video** | Provide captions or transcripts for video | We recommend these settings when you produce your video:  
- **Resolution**: 640 x 480px (Standard) / 640 x 360px (Widescreen) or 800 x 600px (Standard) / 1280 x 720px (Widescreen.)  
- **Video format**: mp4  
- **Audio**: Make sure you record in a quiet location with minimal background noise. |
| | Caption video using YouTube. | After uploading your video to YouTube, go to the following link for captioning instruction:  
1. Go to [https://support.google.com/youtube/answer/2734796?hl=en](https://support.google.com/youtube/answer/2734796?hl=en) |
| | Caption video using Camtasia (Windows.) | 1. Select the audio tracks.  
2. Click on **Captions** tab > **Speech-to-text** button at the top.  
3. The **Speech-to-Text** window will open. Click the **Continue** button.  
   To improve accuracy, select **Train your computer to understand your voice** > **Start voice training** and follow the instructions.  
4. After your captions have been generated, they will appear on the top track in the timeline. Check for accuracy, if editing is needed, press the tab key to edit each line. |
| **Audio** | Provide a transcript for audio that you produce, if it will be used for more than one term. | What to do when you have an audio file that needs transcription?  
1. Have the audio file ready as **mp3**, **wav**, **aiff**, or **wma** format.  
2. Transcribe your audio.  
3. When done, save the file as a document file such as **.txt**, **.rtf**, **.doc** or **.docx**.  
4. Post the transcript file along with the audio file in your course.  
Tips when transcribing an audio recording:  
- **Headsets**: Ensure that you have good quality headsets.  
- **Quiet environment**: A quiet space will help maximize your ability to hear the audio.  
- **Spell check**: Use Spelling & Grammar check on MS Word. |
# How to Make Accessible Math & Science Content

<table>
<thead>
<tr>
<th>Component</th>
<th>Math Tools</th>
<th>Best Practices</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Math &amp; Science equations, formulas and notation</strong></td>
<td>▪ Desire2Learn (D2L)</td>
<td>Given the awards and recognition D2L has won in the area of accessibility, we recommend that as much of the online class as possible be conducted within D2L. All output from D2L’s equation editor is stored as MathML, which is screen reader-accessible.</td>
</tr>
<tr>
<td></td>
<td>▪ MathML</td>
<td>MathML stands for ‘Math Markup Language’ which is the standard for online math accessibility. Typically, a user does not create MathML from source, but instead uses a conversion process to output MathML.</td>
</tr>
<tr>
<td></td>
<td>▪ LaTeX</td>
<td>LaTeX is a mark-up language. Converting LaTeX documents into an accessible format is usually straightforward as the accessible formats are also mark-up languages.</td>
</tr>
<tr>
<td></td>
<td>▪ MS Word + MathType</td>
<td>MathType is an equation editor created by Design Science that is compatible with MS Word for Windows. Together, MS Word with MathType can be exported as MathML or it can be converted to braille. (Save your source files.)</td>
</tr>
<tr>
<td></td>
<td>▪ LibreOffice</td>
<td>LibreOffice (with its native equation editor) converts easily to web pages that contain MathML.</td>
</tr>
<tr>
<td></td>
<td>▪ Graphs</td>
<td>There are many ways to create graphs, including Winplot, Excel, Graph, pgfplots, PSTricks, etc. Any graph or graphic, regardless of how it was created, will always be read as an image by a screen reader. As such, appropriate alt text must be included.</td>
</tr>
<tr>
<td></td>
<td>▪ WeBWorK</td>
<td>WeBWorK has a variety of screen output options, including MathJax which can be configured (easily) to use MathML.</td>
</tr>
<tr>
<td></td>
<td>▪ MS PowerPoint</td>
<td>Math is not accessible in PowerPoint.</td>
</tr>
<tr>
<td></td>
<td>▪ PDF</td>
<td>Math is not accessible in PDF.</td>
</tr>
</tbody>
</table>
# Using Publishers’ Online Materials

<table>
<thead>
<tr>
<th>Ask about</th>
<th>Questions and Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The accessibility of their materials</strong></td>
<td>- Are the videos captioned and audio recordings transcribed? There should be transcripts for audio recordings and captions or subtitles for video. If they aren’t available, ask the publishing representative if they would provide a captioned version in a timely manner if a student who needed them registered for your class.</td>
</tr>
<tr>
<td></td>
<td>- Can all of the text that is displayed on the screen be read aloud by text-to-speech software? Screen readers (assistive technology used by people who are blind) read real text. They cannot read images of text or text embedded in Flash animations/movies/simulations.</td>
</tr>
<tr>
<td></td>
<td>- How accessible are the E-books? Check to see if you can find a Document Accessibility Profile (DAP) (currently in beta) on the e-book. The goal of DAP is to make it easy to find and use accessibility information for electronic textbooks and other documents.</td>
</tr>
<tr>
<td></td>
<td>- Can all interactivity (media players, quizzes, flashcards, etc.) be completed by keyboard alone (no mouse required)? People who are blind or people who have upper mobility disabilities cannot use a mouse. They use the keyboard to navigate and interact with the Web. It is required that any interactive elements on a publisher's website (or on a DVD included with the book) be operable by a keyboard alone if they are used in your course.</td>
</tr>
<tr>
<td></td>
<td>- Is there any documentation available (VPAT or White Paper for example) that confirms accessibility or usability testing results? A VPAT is a Voluntary Product Accessibility Template. It is used by many organizations to report the level of accessibility of their software products.</td>
</tr>
</tbody>
</table>

| The usability and interoperability of their materials | - Is your multimedia (Adobe) Flash or (Oracle) Java-based? Or Can your materials be watched on mobile devices? Content created in Flash or Java can be inaccessible and may not run on mobile devices and tablets, which are becoming more prevalent. |
| | - Does any software need to be installed on students' computers? If software needs to be installed on computers in a particular lab, consult with that lab’s coordinator. |
| | - What are the computer requirements for using their materials? Will the materials work on mobile devices? Distance Learning informs online students about the computer requirements for taking an online course in the Distance Education Orientation for students. If your course requirements are different, make the computer requirements known in the course syllabus. |
| | - How will students get access to the materials? Does it require an access code? If so, students should be aware that used books may not have the necessary access code or may have an old and unusable code. |
| | - Can the electronic content be made available for purchase through the bookstore? Some students would like to own the material so they have it for future reference (rather than just online during the term.) |
WEB ACCESSIBILITY

Training & Support

- Check the ATC website for how-to instructions & video tutorials
  http://uwf.edu/offices/academic-technology-center/faculty-support-and-resources/accessibility/

- Questions about online course accessibility:
  Cindy Mersereau: 850-474-3291 | cmersereau@uwf.edu
  June Watkins: 850-474-3165 | jwatkins1@uwf.edu
  Lior Flum: 850-473-7239 | lflum@uwf.edu

Firefox & IE: Favelets
http://jimthatcher.com/favelets/

Firefox: WAVE Toolbar
http://wave.webaim.org/toolbar/

MS Word: Built-in 2010, 2013

MS PowerPoint: Built-in 2010, 2013

PDF: Built-in Adobe Acrobat Pro

Colour Contrast Analyser
http://www.paciellogroup.com/resources/contrastAnalyser

Other Helpful Websites

- SDRC: http://uwf.edu/offices/student-disability-resource-center/faculty-resources/overview/
- CUTLA: http://uwf.edu/offices/cutla/servicefor/teaching/
- ITS: http://uwf.edu/offices/help-desk/faculty-staff-new-to-uwf/instructor-resources/